Work Planning and Budgeting Tool

User's Manual

For Use in Preparing Funding Applications to The Global Fund to Fight AIDS, Tuberculosis and Malaria

Round 10

May 2010
# Table of Contents

1. **INTRODUCTION**  
   5

2. **THE USER’S MANUAL IN BRIEF**  
   6
   2.1 The user’s manual  
   6
   2.2 Installing the tool  
      7
      2.2.1 System requirements  
      7
      2.2.2 Installation procedure  
      8
      2.2.3 Enabling macros  
      8
      2.2.4 Selecting your language  
      10
   2.3 Conventions used in the tool  
      10
      2.3.1 Protection  
      10
      2.3.2 Colour coding  
      11
      2.3.3 Copying and pasting  
      11
      2.3.4 Backup procedure  
      14
   2.4 The work-planning and budgeting team  
   14

3. **DETAILED INSTRUCTIONS FOR COMPLETING THE TOOL**  
   14
   3.1 Overview  
   14
   3.2 Step 1: Cover sheet details  
      17
      3.2.1 Project title and country  
      17
      3.2.2 Component  
      18
      3.2.3 Enter currencies  
      18
      3.2.4 Enter version number  
      18
      3.2.5 Annex number and name  
      19
      3.2.6 Print the tool for submission  
      19
   3.3 Step 2: General assumptions  
      19
      3.3.1 Basic data  
      19
      3.3.2 Context for this costing/budget  
      21
   3.4 Step 3: Define the logical framework  
      21
      3.4.1 Numbering convention  
      22
      3.4.2 Constructing the logical framework  
      22
      3.4.3 Changing the framework structure  
      23
      3.4.4 Input of data  
      25
      3.4.5 Selecting service delivery areas  
      26
3.5  Step 4: Define input costs
   3.5.1  General approach to input costs
   3.5.2  Cost categories
   3.5.3  Data input
   3.5.4  Additional guidance on defining input costs

3.6  Step 5: Input costs and reference notes
   3.6.1  Input cost values
   3.6.2  Exchange rates
   3.6.3  Apply inflation
   3.6.4  Notes
   3.6.5  Source of data

3.7  Step 6: Calculate input costs
   3.7.1  Using the cost calculation notes
   3.7.2  Per unit costs

3.8  Step 7: Define input cost items and quantities for sub-activities
   3.8.1  Selecting inputs
   3.8.2  Estimating quantities

3.9  Step 8: Financial reports

3.10 Step 9: Other reports
   3.10.1  Detailed budget
   3.10.2  Unit cost / detailed assumptions
   3.10.3  Unit cost calculations
   3.10.4  Proposal work plan

3.11 Print model reports for submission

4.  TROUBLESHOOTING AND SUPPORT

4.1  Technical support

4.2  Troubleshooting
   4.2.1  The programme or certain functions do not respond when I try to use them.
   4.2.2  The tool is slow to respond and functions such as report printing take a long time
   4.2.3  The totals in the summary budget reports do not match each other
   4.2.4  I have pasted data into a cell and now I cannot change it
   4.2.5  When I perform a certain function a run-time error message appears
Table of Figures

Figure 2-1: Enabling macros in Excel 2003 ................................................................. 9
Figure 2-2: Enabling macros in Excel 2007 ............................................................... 10
Figure 2-3: Error message for a protected cell ...................................................... 11
Figure 2-4 Type of staff required to complete the tool ......................................... 14
Figure 3-1: Tool menu outlining key steps ............................................................. 15
Figure 3-2: Overview of steps required to complete the tool ................................. 16
Figure 3-3: Cover sheet example ........................................................................... 17
Figure 3-4: WHO hierarchy of planning elements – the logical framework ............ 21
Figure 3-5: Numbering convention ....................................................................... 22
Figure 3-6: Overview of master worksheet – construction of the logical framework ............................................................... 23
Figure 3-7: Edit the structure of the logical framework – right-click commands ............................................................... 24
Figure 3-8: Functionality of various commands .................................................... 24
Figure 3-9: Input Costs .......................................................................................... 27
Figure 3-10: Defining the input costs on the input cost sheet .................................. 28
Figure 3-11: Inserting input cost rows ................................................................. 29
Figure 3-12: Inserting values and source data for defined input costs .................. 32
Figure 3-13: Example of an aggregate unit cost calculation ................................... 35
Figure 3-14: Input cost item commands in the master work plan and costing sheet ............................................................... 38
Figure 3-15: Summary reporting menu ................................................................. 40
Figure 3-16: Budget by cost category and budget by objective and SDA reports .... 40
Figure 3-17: Other reports menu ........................................................................... 41
Figure 3-18: List of reports included in the Print Model option in Step 1 ............... 42

List of Abbreviations and Acronyms

ART    Antiretroviral therapy
ARV    Antiretroviral (drugs)
ASAP   AIDS Strategy and Action Plan (World Bank)
DSA    Daily subsistence allowance
GB     Gigabyte
GF     The Global Fund (abbreviation used in parts of the tool)
HSS    Health systems strengthening
MB     Megabyte
NASA   National AIDS Spending Assessment
RAM    Random Access Memory
SDA    Service delivery area
WHO    World Health Organization
1. **Introduction**

The Work Planning and Budgeting Tool (referred to as the tool in this document) has been developed by WHO to assist countries in developing funding applications to the Global Fund to Fight AIDS, Tuberculosis and Malaria (referred to as The Global Fund in this document). It has been updated and revised in preparation for Round 10 proposals.

The main purpose of this tool is to facilitate the development of well-structured work plans and accurately costed budgets for Global Fund proposals, and to express these in a format acceptable to the Global Fund.

The tool is designed to make the planning and costing exercise more automated, accurate and user-friendly. Many of the functions associated with the development of the work plan and budget are automated, and cost calculations are protected to avoid errors and omissions. Above all, the tool is designed to promote consistency between the proposal work plan and the detailed budget, and aims to improve the overall quality of Global Fund applications.

The model design has been based on a review of best practice design concepts developed from a review of existing models (including the costing template developed by the Global Fund for Round 8 and 9 applications) and after consulting with a number of costing consultants, government officials and other professionals involved in costing funding proposals. An effort has also been made to create some visual consistency with the recently developed World Bank AIDS Strategy and Action Plan (ASAP) Activity-based Costing tool, which is aimed primarily at costing strategies and operational plans.

In keeping with the requirements of the Global Fund and most operational plans, the tool is designed to budget an activity-based structure. It breaks quantity and costing data down by quarter for the first two years of the proposal and by year for years three to five. All the data are included on one planning worksheet with totals by year and for the total duration of the project. The programme generates summary sheets that include work plans and budgets as well as budget summaries by service delivery areas and cost categories.

The tool has been developed for use in costing HIV/AIDS, tuberculosis and malaria proposals, but it is generic and can be used to develop and cost other plans and proposals as well.

This user's manual contains detailed instructions on how to use the tool. It also contains a number of warnings about possible errors that may occur if the tool is not used correctly. Failure to follow the instructions contained in the user's manual may lead to errors in using the tool and may result in an incomplete or incorrect work plan and budget.

**Users are strongly advised to carefully read the entire manual before attempting to install and use the tool.**

This tool is accompanied by a second tool designed to help users compile lists of drugs and other commodities for antiretroviral therapy (see Annex A for the quantities tool). The final report generated by the quantities tool is similar in format to Attachment B of the required Global
Fund proposal documentation and can be submitted with Global Fund proposals. Currently this tool is available only for the HIV component.

Both the work planning and quantities tools and their accompanying user’s manuals are available in English, Spanish and French. The tools contain an option to select the language of the tool when it is installed. Subsequent changes in the language are not possible.

2. The user’s manual in brief

2.1 The user’s manual

The purpose of this user’s manual is to provide the user with instructions to install and correctly use the tool. The user’s manual can also assist users to resolve problems that may occur.

Although the tool has been designed to lead the user through the various steps to complete the work plan and budget, detailed instructions are only contained in the user’s manual. The user’s manual must be read completely before the tool is installed and used. Failure to do so may lead to incorrect completion of the tool and may result in a work plan and budget that contains errors.

The user’s manual comprises four sections:

1. Section 1 – An introduction, which provides a brief background to the development of the tool and its primary purpose.
2. Section 2 – An overview of the user’s manual, the conventions used in the manual and the tool, and instructions for installing and running the tool.
3. Section 3 – The bulk of the user’s manual, which provides detailed instructions for using the tool. In order to improve the readability of Section 3, the following structure has been followed for each step:
   • Introductory paragraphs that describe the logic and purpose of that step;
   • Specific instructions for completing the step.
4. Section 4 – A troubleshooting section with a list of possible problems and solutions that may be experienced and contact details for technical support.

Where possible, screenshots of the tool’s workbook have been included to illustrate each step and assist in the learning and problem-solving process.

The instructions frequently refer to headings or commands in the tool. These are identified in bold, as in: Right-click the mouse and select the Add note command from the command box.

Where the user is referred to menu options in Excel, the menu items and commands have been highlighted in blue, for example, File > Print Preview > Print.

Throughout the document, tips have been shown in blue boxes, as shown below, to assist in the execution of specific instructions.
**TIP:** Build the early versions of the logical framework outside the tool while significant changes are still being made. Once some consensus has been achieved with respect to the framework, capture it in the tool. This limits the amount of editing required within the tool.

Where the attention of the user must be drawn to critical issues or warnings, these have been highlighted in each section in an orange box, as shown below. Ignoring these warnings will lead to the incorrect completion of the tool.

**Caution!** It is not possible to change the disease component after the tool has been populated and the logical framework has been developed. Each tool is therefore dedicated to a single disease.

### 2.2 Installing the tool

**Caution!** Please read section 2.2 completely before installing the tool.

#### 2.2.1 System requirements

This tool was developed in Excel 2003, and any user with this or a later version of Excel should not need additional software. Due to the large number of macros used in the tool, the use of an older version of Excel will result in errors and the tool will not function properly.

The tool was tested on three relatively new laptop computers (less than a year old) using either Vista or Windows 7 operating systems. All laptops had dual core processors generating processor speeds of between 1.6 and 2.1 MHz. Random Access Memory (RAM) ranged between 3 and 4 gigabytes (GB). Testing comprised the re-capture of three Round 9 Global Fund proposal budgets. The tool worked correctly on these tests, although some functions were slow as the amount of data entered increased. A populated version of the tool was also run on an older computer with limited capacity (Windows XP, Pentium 4, 1.69 GHz and 512 megabytes (MB) of RAM). The tool worked correctly on this computer with no noticeable reduction in speed.

To check the capacity of your computer, go to **Start > Control Panel > System**. Click on **System** and check to see that your computer has at least the capacity outlined below:

<table>
<thead>
<tr>
<th>Item</th>
<th>Capacity Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excel</td>
<td>Excel 2003 or later</td>
</tr>
<tr>
<td>Operating system</td>
<td>Windows XP, Vista or Windows 7</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium 4 or better</td>
</tr>
<tr>
<td>Processor speed</td>
<td>1.69 GHz or better</td>
</tr>
<tr>
<td>RAM</td>
<td>At least 512 MB</td>
</tr>
</tbody>
</table>

For best results it is recommended that the tool be used only on a computer with a new generation (duo core) processor and at least 3 GB of RAM.
Many other settings and Windows set-up options influence the capacity and speed of any computer. Please consult an expert to ensure that these have been set to maximize the processing speed and performance of your computer. Requirements may also change depending on the operating system you are using. Windows Vista or Windows 7 require more than the minimum capacity specified above. With these operating systems the tool may not operate with less than 3 GB of RAM.

The tool requires a relatively large amount of memory and processing power to operate. The system requirements increase significantly as the tool is populated with data. Some functions, such as updating the master work plan or generating reports, may take 10-15 seconds in a fully populated version of the tool. Users should be patient and wait for these processes to finish before attempting further entries.

It is not recommended to run more than one version of the tool at the same time on the same computer, or to operate it together with other complicated software. This may slow the operation of the tool and could lead to a "crash" of the programme.

2.2.2 Installation procedure

This tool can be copied from portable media (CD or USB drive) or downloaded from http://www.who.int/hiv/pub/toolkits/GF-Resourcekit/en/index2.html.

To open the tool, simply copy the file into an appropriate location (specified by you), open the file in Excel and follow the instructions regarding the security settings in Section 2.2.3 below. Careful attention must be paid to the security settings, as these will have an impact on the functioning of the macros.

To create a shortcut to the file on the desktop, right-click on the desktop and follow the shortcut wizard instructions.

2.2.3 Enabling macros

This tool contains macros. It will not function correctly unless the macros are enabled. To ensure macros are enabled, you must adjust the security settings to the appropriate level before opening the workbook.

In Excel 2003, before opening the workbook, go to the Tools > Macro > Security menus and set the security setting to Low or Medium (see Figure 2-1 below). If you choose Low macros will be enabled automatically. If you choose Medium you will be prompted to enable or disable macros when you open the workbook. Ensure that you enable the macros when prompted to do so.
In Excel 2007, a security warning will appear above the worksheet. To the right of the warning is an Options button. Click on the Options button and then click on Enable this content. Then click on OK. The procedure needs to be repeated each time a workbook is opened as macro settings sometimes change when the workbook is closed.

In Excel 2007, it is possible to enable all macros permanently in the trust centre (see Figure 2-2 below). This is not recommended as it may result in the execution of unauthorized code. Should you, however, wish to do so then click on the Office button (the round button at the uppermost left corner of the worksheet) and go to Excel options > Trust centre > Trust centre settings > Macro settings. Check Enable all macros and finish by clicking OK.
2.2.4 Selecting your language

The tool is available in English, French or Spanish. The first time the tool is opened, the user will be prompted to select one of these languages. From the drop-down menu, select the language in which you would like to complete the tool.

Once a language has been selected, the headings and instructions in the tool will be translated into your language. When the tool is opened subsequently, you will be taken directly to the workflow menu. Please note that the tool currently does not support changing the language once the initial selection has been made.

Caution! It is not possible to change the language after the initial language selection has been made.

2.3 Conventions used in the tool

2.3.1 Protection

The tool contains numerous macros and formulas and it will return incorrect results if these are changed or deleted. The tool is protected to prevent inadvertent deletion or corruption of macros and formulas during data entry. This protection may restrict the flexibility of the tool in certain instances and imposes some limitations on users. The stability and accuracy of the tool is,
however, significantly improved as a result.

### 2.3.2 Colour coding

In an effort to assist users, colours have been used to indicate where data must be entered, where data have been calculated and where a result has been generated. The following colour codes apply to the tool:

<table>
<thead>
<tr>
<th>Colour</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Data must be entered or selected from a drop-down list.</td>
</tr>
<tr>
<td>Light Green</td>
<td>Data have been entered or selected on at least one occasion.</td>
</tr>
<tr>
<td>Blue</td>
<td>Data have been calculated by the tool or are derived from elsewhere in the tool. No data entry needs to take place in these cells, which have been protected from further changes.</td>
</tr>
<tr>
<td>White</td>
<td>In the reports, results from the tool are reflected in a white field and are protected.</td>
</tr>
</tbody>
</table>

### 2.3.3 Copying and pasting

The tool has been designed to facilitate direct data entry where input data is required. It has **not** been designed to facilitate the pasting of lists of data or multiple cells from a source spreadsheet. Copying and pasting data may create errors or other problems. In some sheets the insertion of data into a cell activates a macro, and attempting to copy and paste more than one cell at a time will generate an error message (see Figure 2-3 below). Elsewhere in the tool, destination cells may be protected. Pasting into these protected cells will generate an error message, as this action will attempt to override protected formats.

**Figure 2-3: Error message for a protected cell**

![Error message for a protected cell](image)

It is strongly recommended that the user enter the data directly into the tool cell by cell. However, there may be cases where users may wish to cut or copy text from Word documents or other spreadsheets and paste it into the tool. Most steps in the tool can accommodate this, but some difficulties may be encountered when using this technique.
To avoid such problems, only the content of a cell should be copied, without formats or other embedded commands. There are a number of ways to do this:

1. **Paste Special function (recommended):** To avoid pasting formats and other commands from the source cell, you may use the Paste Special command. To do this, copy the cell from the source sheet using the normal Copy command. Then place the cursor in the destination cell.

   In Excel 2007, select the Paste drop-down list on the Clipboard group on the Home tab. Then select the Paste Special command and click the Text or Values button. (Do not select the All or Format option buttons.) Under the Operations heading, select None. Click on OK and the value of the cell will be pasted without the formats.

   In Excel 2003, the Paste Special command can be selected from the right-click command box or from the Edit function. Note that the Paste Special command is frequently not available from the right-click command box in the tool, as the command box is often used to locate and execute many of the tool’s macros.

   The Paste Special function also works to copy and paste multiple cells at a time.

2. **Excel cell edit text function:** The edit text function allows you to "enter" a cell and copy or paste text within the cell without copying and pasting formats or other commands. To copy text or values (not formulas) from an Excel spreadsheet to the tool (e.g. an activity description), select the cell in the source sheet and double-click. Select the content to be copied from within the cell and select the Copy command. Next, place the cursor on the destination cell in the tool, double-click on the destination cell, select any existing text and select the Paste command. This process will copy the text or value only and not the format associated with the source cell.

3. **F2 Function:** The F2 button on your keyboard functions like the edit text function. To copy text or values from an Excel spreadsheet to the tool, select the cell in the source sheet and press the F2 button on your keyboard. This "enters" the cell. Then select the text or numbers to be copied from within the cell and use the normal Copy command. Next, place the cursor on the destination cell in the tool, press the F2 button, select any existing text and select the Paste command. This process will copy the text or value only and not the format associated with the source cell.

Text or numbers can be copied from Word documents using the same procedures outlined above. As with Excel, the Paste Special or another method should be used to avoid copying and pasting formats from the source document into the tool.

If the normal Paste command is used in place of one of the above methods, you will copy
formats and other embedded commands into the tool. Often this will include a command to lock the cell. When this happens, you will no longer be able to change the content of that cell.

**Caution!** If the procedure for copying and pasting is not strictly followed, the result may be cells with incorrect data that cannot be changed. If a complete cell is copied, the formats and embedded commands will also be copied. Often this includes a "lock" command that will prevent any subsequent changes to the cell.

The edit text and F2 methods will paste text into the destination cell in addition to any text that already exists there. To avoid this, ensure that the existing text or values are selected before the Paste special command is selected. The text or value being copied will then replace the existing text.

When formats have accidentally been copied into the tool’s destination worksheet, it may be possible to use the format painter to copy the format from an adjoining cell. To use the format painter, select a cell with the correct format on the same worksheet. In Excel 2007, click on Format Painter located in the Clipboard group on the Home tab. Drag the painter cursor across the cell that has the incorrect format. In Excel 2003, the Format Painter can be found on the standard toolbar. Select the format to copy, click on the format painter, then click on the cell you wish to format. The format will be copied automatically.

In worksheets where copying and pasting of more than one cell at a time is not permitted, where destination cells are protected, or where the user wishes to copy text into a numeric cell, the above methods will not work and an error message will be displayed.

Users may also experience difficulty when trying to copy and paste merged cells. Excel cannot copy and paste data from one place to another if the size of the source and destination cells are not identical. If the source data are located in a single cell, they can usually be copied and pasted into a destination that contains two or more merged cells. However, if data are copied from a block that contains two or more merged cells, they cannot be copied into a block that contains a different number of merged cells. If this is attempted, the following error message will appear:

```
Microsoft Excel

Cannot change part of a merged cell.

OK
```

In some cases entering value data (as opposed to narrative data) also initiates a macro. Where more than one cell is copied from a source to several destination cells, the macro will only run on the first destination cell. For the macro to run accurately, the data must then be entered into the other destination cells as well.

**To avoid these issues, it is strongly recommended that users enter values manually, cell by cell.** If electing to copy and paste, it is recommended to copy and paste data in only one cell at a
2.3.4 Back-up procedure

During a costing exercise, it is critical that the tool is saved frequently during use and backed up at least once a day on an external storage device. If working on a network, this back-up may take place automatically. In many situations this is not the case and the user is required to manually back up onto an external hard drive or similar device.

When backing up it is critical that a unique identification and date filed is included in the backup file name to ensure that the user is able to keep track of the latest version of the file. The cover sheet of the tool itself also provides the user with an opportunity to enter a new version number each time the tool is used.

2.4 The work-planning and budgeting team

The development of an accurately costed budget for a Global Fund proposal requires teamwork. To work through the budget development steps successfully, various types of staff from the various sectors, HIV/AIDS councils and programmes and/or other stakeholders should be involved. All core team members should participate in the initial planning discussions and be involved at key stages of the proposal development process. Team members should have a good understanding of the workings of the tool and the dependencies between the various components of the tool.

The table in Figure 2-4 below highlights the types of staff who should be involved in completing each step of the tool. It is not appropriate to expect the costing or finance professional to complete the costing tool alone.

Figure 2-4 Type of staff required to complete the tool

<table>
<thead>
<tr>
<th>Step</th>
<th>Type of Staff</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover sheet and general assumptions</td>
<td>Programme and financial</td>
</tr>
<tr>
<td>Develop programme logical structure</td>
<td>Programme, M &amp; E and financial</td>
</tr>
<tr>
<td>Define required input unit costs</td>
<td>Financial</td>
</tr>
<tr>
<td>Calculate and finalize input costs</td>
<td>Financial</td>
</tr>
<tr>
<td>Enter sub-activity input cost items</td>
<td>Financial and programme</td>
</tr>
<tr>
<td>Enter input cost targets</td>
<td>Program and M &amp; E</td>
</tr>
<tr>
<td>Review total costs</td>
<td>Management</td>
</tr>
<tr>
<td>Reporting</td>
<td>Financial and programme</td>
</tr>
</tbody>
</table>

3. Detailed instructions for completing the tool

3.1 Overview

In designing the tool, every effort has been made to encourage the user to complete a defined
series of steps that will lead to the completion of a logical programme or proposal structure that is accurately costed. In order to achieve this, the user must follow a menu-driven sequence of steps that require the completion of various set-up, costing and linking tasks. The end result of these steps is a fully costed proposal budget.

The level of detail to be included in the costing is determined largely by Global Fund requirements or the overriding purpose of the planning and costing exercise. Although experienced users may be frustrated by the need to return to the menu to move between steps, the use of the menu triggers auto-save and other macro-driven functions that are aimed at enhancing the overall stability and robustness of the tool.

Figure 3-1 below shows the tool’s main menu with each step clearly named. Clicking on any step will result in the user being transferred to the appropriate worksheet. A return button is provided on each worksheet to transfer the user back to the menu.

Figure 3-1: Tool menu outlining key steps

There are a total of nine steps to be completed. A brief overview of these steps is included in the table in Figure 3-2 below. Each step is described in detail in subsequent sections.
**Figure 3-2: Overview of steps required to complete the tool**

<table>
<thead>
<tr>
<th>Step in menu</th>
<th>Description and function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1: Cover sheet details</td>
<td>The cover sheet provides a cover to the electronic and printed version of the tool output. On the cover sheet the user is required to enter information relating to the project title, country name, disease component, currency and other necessary information to facilitate the administrative control of the tool.</td>
</tr>
<tr>
<td>Step 2: General assumptions</td>
<td>On this sheet the general assumptions applicable to the costing must be entered and include items such as the exchange rate between the local and reporting currency, the unit of reporting, the inflation rate and project start year. A narrative section requires the description of contextual information for the planning and costing.</td>
</tr>
<tr>
<td>Step 3: Define the logical framework</td>
<td>This step requires the user to define the logical structure for the programme or proposal. Following Global Fund convention, the structure includes goals, objectives, service delivery areas, activities and sub-activities. Defining the logical structure must be largely complete before the costing can be started. This sheet is known as the master worksheet.</td>
</tr>
<tr>
<td>Step 4: Define the required unit costs</td>
<td>Once the logical structure has been defined, the user is encouraged to list and identify (not quantify) all input cost items that will be required to cost the sub-activities in the structure. The input cost items must also be linked to a Global Fund cost category and the unit of measure described.</td>
</tr>
<tr>
<td>Step 5: Input costs and reference notes</td>
<td>Next, the user is required to enter a value for each input cost defined. Where an input cost has been aggregated and a calculation is required, a note can be inserted and referenced at this point in the process. The note is completed in Step 6. It is also on this worksheet that the user will decide how the item will be affected by inflation. Data sources must be carefully documented for each item.</td>
</tr>
<tr>
<td>Step 6: Calculate the input costs</td>
<td>Where possible the user is encouraged to calculate aggregate input costs that are then transferred to the actual input cost sheets. These input costs calculations are presented on a separate sheet and only the total is transferred to the input costs sheet. A blank note is created and automatically referenced during Step 5.</td>
</tr>
<tr>
<td>Step 7: Enter the sub-activity targets and input costs</td>
<td>On the master worksheet, the user is required to select input costs from a drop-down list for each sub-activity until the sub-activity is fully costed. A brief description of the activity will guide the selection of input costs. The cost category, unit of measure and value will be automatically transferred from the input cost sheet. A separate column is, however, provided for additional notes and assumptions relating to the costing of the sub-activity. Importantly, the user must also enter quantities for each of the input cost items selected.</td>
</tr>
</tbody>
</table>
3.2 Step 1: Cover sheet details

In this step, complete the cover sheet with general proposal-related information (see Figure 3-3 below for an example). Completion of the cover sheet is important, as the project title and details are automatically reflected on all the subsequent worksheets.

Figure 3-3: Cover sheet example

<table>
<thead>
<tr>
<th>Workplan and budgeting tool</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project title:</strong></td>
</tr>
<tr>
<td><strong>Country:</strong></td>
</tr>
<tr>
<td><strong>Component:</strong></td>
</tr>
<tr>
<td><strong>Proposal currency:</strong></td>
</tr>
<tr>
<td><strong>Local currency:</strong></td>
</tr>
<tr>
<td><strong>Report currency:</strong></td>
</tr>
<tr>
<td><strong>Version # and date:</strong></td>
</tr>
<tr>
<td><strong>Date of submission:</strong></td>
</tr>
<tr>
<td><strong>Language:</strong></td>
</tr>
<tr>
<td><strong>Annex number:</strong></td>
</tr>
<tr>
<td><strong>Annex name:</strong></td>
</tr>
</tbody>
</table>

3.2.1 Project title and country

On the cover sheet, enter the title of the project and the country submitting the proposal. Select the proposal disease component and the reporting currency from the drop-down list by placing the cursor in the appropriate cell. Enter the version number and date as well as the required date of submission in the empty fields provided for this purpose. Where the work plan
and detailed budget are annexed to the proposal document, enter the correct annex number in the smaller table below the main cover sheet table.

3.2.2 Component

To select the disease component, click on the green field to the right of the Component heading. Click on the drop-down arrow and select the disease component or health systems strengthening (HSS) from the drop-down menu.

The selection of the disease component will generate the appropriate drop-down list for disease-specific service delivery areas (SDAs) in the master worksheet. This drop-down list is used for selecting SDAs when developing the logical framework.

Caution! It is not possible to change the disease component after the tool has been populated and the logical framework has been developed. Each tool is therefore dedicated to a single disease or health systems component.

3.2.3 Enter currencies

The tool requires three currencies to be entered:

1. Proposal currency – this is the currency in which the proposal is to be denominated. The Global Fund requires that proposals be denominated in either USD or Euros. Select the proposal currency from the drop-down list.
2. Local currency – Enter the name of the national currency.
3. Report currency – Enter the currency in which you would like to have reports generated. For Global Fund proposals, this would normally be the same as the proposal currency. However, countries may find it useful to have reports generated in their local currency as well.

The tool supports entering cost data in a mix of the local and proposal currency. In Step 2 the user is guided to include an exchange rate that will calculate the conversion of local to proposal currency and vice versa.

The currency fields can be changed at any time during the creation of the budget and the new currency names will be reflected in the tool. However, no automatic conversion from one currency to another takes place. This can only be done by changing the exchange rate in Step 2. Users must therefore take care to ensure that the name of the currency entered corresponds to the currency in which costs are entered.

The currencies entered on the cover sheet will feed into additional calculations in Step 2 and beyond.

3.2.4 Enter version number

In developing proposals it often happens that several versions of the budget may exist. It is useful to assign version numbers and dates to these to avoid confusion. The tool provides a place to record and label different version numbers and dates on the cover page. Simply enter a
new version number of your choice and date every time a new version of the tool is created. Similarly, a field is available to record the date of submission to the Global Fund.

3.2.5 Annex number and name

A printed copy of the detailed Global Fund proposal budget must be annexed to the main body of the proposal. Given the long list of attachments that accompany the main proposal, the printed budget must be clearly identified in the table of contents of the main proposal document. The tool includes a feature to record the correct annex number and annex name. When printing the tool from the cover page, the cover page is included in the printout together with the annex number and name (see Section 3.2.6 below).

Enter the annex number and name from the proposal table of contents into the green cells provided.

3.2.6 Print the tool for submission

The entire tool can be printed from Step 1. To print the tool, click on the button labelled Print Model. The tool will then generate reports for Steps 1-7 and transfer the user to the print preview screen. Check all the reports for accuracy and consistency. To print, use the normal Print command in the Excel toolbar.

More detailed instructions for using this function are contained in Section 3.11 below.

3.3 Step 2: General assumptions

The general assumptions worksheet documents the key financial assumptions that underpin the calculations in the tool (see Figure 3-4 below). The worksheet title and step descriptions are automatically reflected and linked to the cover sheet.

On this worksheet, it is also possible to document macro-level assumptions that provide a context for the work planning and costing. Contextual issues may include macroeconomic or political issues, institutional arrangements and the status quo of current funding.

3.3.1 Basic data

Enter the required information for all items in the green cells. This includes:

1. The **start year** for the budget. The tool will automatically calculate the subsequent years for the budget.

2. **Exchange rate.** It is important that the exchange rate be entered in national currency units per unit of the proposal currency (NOT as number of proposal currency units per local currency unit). For example, if there are 20 local currency units per dollar, enter this as 20, not as 0.05. If this number is entered incorrectly, the budget will be incorrect.

3. **Scales for national and proposal currencies.** The tool supports a selection of scale (units,
thousands, millions) to simplify large numbers. When units are selected, the cost figures are expressed in units of national or proposal currency units. When thousands are selected, the numbers are expressed in thousands of currency units, and so on. This option can be selected independently for local and proposal currencies. Click on the green field for scale of national currency and select the scale from the drop-down menu for both national currency and proposal currency reports from the drop-down list. The selection of scale will be used in the tool and reports.

4. **Inflation rate.** Enter the average estimated inflation rate in the proposal currency for the period of the budget in the cell provided. The entry must be made in percentage points (e.g. for 5.8%, enter 5.8 not 0.058). This rate will be used as the default inflation rate in the costing tool. If no inflation is provided for, then a zero must be entered here. In Step 5, the user can choose whether or not to apply the default inflation rate for specific input cost items. Not applying the inflation rate means that the item will not be inflated.

5. **Productive work time.** The data categories **Productive days in work year** and **Productive hours in work year** require information on the standard number of working days per annum and hours per day. These fields are optional but may be useful where input costs require the calculation of a human resource component. These cells have no dependents and are not required inputs for subsequent calculations.

---

**Figure 3-4: General assumptions table**

<table>
<thead>
<tr>
<th>Project Name</th>
<th>WHO Budgeting tool</th>
<th>Test Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>HIV/AIDS</td>
<td>Version 1.1 7 June 2010</td>
</tr>
</tbody>
</table>

**Step 2 - General assumptions**

<table>
<thead>
<tr>
<th>Basic Data</th>
<th>Test Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>ZAR</td>
</tr>
<tr>
<td>Start year for projection</td>
<td>2010</td>
</tr>
<tr>
<td>Local currency</td>
<td>Units</td>
</tr>
<tr>
<td>Scale for local currency</td>
<td>1</td>
</tr>
<tr>
<td>Local currency to USD rate (e.g. ZAR 8.00 = USD 1)</td>
<td>7.50</td>
</tr>
<tr>
<td>Proposal currency</td>
<td>USD</td>
</tr>
<tr>
<td>Scale for proposal currency</td>
<td>Units</td>
</tr>
<tr>
<td>Inflation rate per annum</td>
<td>5.00%</td>
</tr>
<tr>
<td>Productive days in work year</td>
<td>0</td>
</tr>
<tr>
<td>Productive hours in workday</td>
<td>0.0</td>
</tr>
</tbody>
</table>

1 The tool uses the default inflation rate to inflate the proposal budget over the proposal period. The inflation rate should be the estimated inflation rate in the proposal currency. It is assumed that the difference between proposal currency and local currency inflation rates will be perfectly offset by changes in the exchange rate.
3.3.2 Context for the budget

The tool also includes a facility to enter general contextual information for the budget such as economic and political issues, institutional and regulatory arrangements, etc. To enter contextual, narrative information double-click anywhere in the Context for the Budget rectangle located below the general assumptions table. The rectangle is an embedded MS Word document and information can be entered as if working with a Word document. Once complete, place the cursor outside of the rectangle and click the mouse to return to Excel mode.

3.4 Step 3: Define the logical framework

The tool is based on the planning structure most often recommended by WHO for structuring Global Fund proposals for HIV/AIDS. This structure is based on a hierarchy of planning elements that cascade down from goals to objectives, SDAs, activities and sub-activities. Input costs and quantities are entered at the level of sub-activities. This structure is equally applicable to any logical planning framework. The logic is illustrated in the schematic in Figure 3-5 below.

Figure 3-5: WHO hierarchy of planning elements – the logical framework
The tool is flexible enough to accommodate activities and sub-activities at any level of detail. However, it is important that proposals be internally consistent in defining these planning elements. All activities and detailed sub-activities should be roughly similar in content and level of detail.

For the best results, construct the proposal logical framework from activities and sub-activities that contain a relatively high level of detail. For the purposes of this tool, activities and sub-activities can be most usefully defined as a set of actions that consume resources and result in a desired primary output. A primary output is the first discrete level of output that can be combined with other outputs in a service delivery area to help achieve objectives and goals. Where a results-based framework has been developed, it is important to define and group activities in such a way that these can easily be related to the detailed output indicators.

For example, a sub-activity might comprise a series of training courses for community outreach workers. The primary output might be a trained cadre of X community outreach workers. The input costs might include salary and subsistence allowance for the trainers and support staff, adaptation and reproduction of training materials, purchase of audio-visual equipment, travel and subsistence for the participants, rental of venue, and so on.

### 3.4.1 Numbering convention

All numbering in the tool is created automatically according to the convention described below. As the logical framework structure is edited and amended, it updates the numbering. Users should not attempt to manually number the planning elements. In the table in Figure 3-6 below, the last column reflects the numbering that will be visible in the tool.

#### Figure 3-6: Numbering convention

<table>
<thead>
<tr>
<th>Goal</th>
<th>Objective</th>
<th>SDA</th>
<th>Activity</th>
<th>Sub-activity</th>
<th>Planning Element Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td>1.1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
<td>1.1.1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td></td>
<td>1.1.1.1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td></td>
<td>1.1.1.2.1</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td></td>
<td>1.2.1.1.1</td>
</tr>
<tr>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td></td>
<td>----</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>3</td>
<td>5</td>
<td></td>
<td>2.1.3.5.3</td>
</tr>
<tr>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td></td>
<td>----</td>
</tr>
</tbody>
</table>

### 3.4.2 Constructing the logical framework

The master work plan and budgeting sheet must be completed in two parts. The first is accessed via Step 3 and is the construction of the logical framework. The second part is accessed via Step 7 and deals with the detailed work plan and budget functions. The logical framework
component allows the core proposal team to define the planning elements in the proposal’s logical framework. This framework underpins the detailed work plan and budget, which are developed at a later stage.

To complete the structure of the logical framework, click on Step 3 on the menu. The user will be transferred to the master work planning and budgeting sheet. The structure of this worksheet reflects the hierarchy of planning elements described above – goals, objectives, SDAs, activities and sub-activities.

When a blank version of the tool is opened, it looks like figure 3-7 below. Note that the initial version of the tool contains only one of each level of planning element - i.e. one goal, one objective, one SDA and so on. To develop a complete proposal framework, users will need to add (and occasionally delete, move or insert) the various elements of the structure. The tool provides functions to do this.

Figure 3-7: Overview of master worksheet – construction of the logical framework

### Master Workplan and Costing

**LOGICAL FRAMEWORK**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Title</th>
<th>Directly Related Indicator</th>
<th>Previous Funding Sources</th>
<th>Responsible for Implementation</th>
<th>Implementing Entity Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Proposal Budget</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Goal 1</td>
<td>Enter goal name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Objective 1.1</td>
<td>Enter objective name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SDA 1.1.1</td>
<td>Select SDA from list</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Activity 1.1.1.1</td>
<td>Enter activity name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Activity description</td>
<td>Enter description</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SubActivity 1.1.1.1.1</td>
<td>Enter sub activity title</td>
<td>Enter funding source</td>
<td>Enter who is responsible</td>
<td>Select entity type from list</td>
<td></td>
</tr>
</tbody>
</table>

When a planning element is added, all its subordinate planning elements are also added. For example, each time a goal is added, a goal, objective, SDA, activity and sub-activity are added. Only subordinate planning elements are added – i.e. those below the added planning element in the planning hierarchy described earlier. Superior planning elements are not added. For example, when an activity is added, the subordinate sub-activity will also be added, but not the SDA, objective or goal. Adding an SDA results in the addition of an SDA, activity and sub-activity, but not an objective or goal. The same conventions apply when deleting, moving or inserting planning elements.

### 3.4.3 Changing the framework structure

Planning elements may be easily manipulated through the right-click function on the mouse. To add, insert, move or delete a planning element, place the cursor on the row of the planning element you wish to change and right-click. A menu will appear that contains a number of options. Simply highlight the appropriate action and left-click. The tool will automatically perform the required function and renumber all the planning elements automatically. There is
no need to manually adjust the numbering in the structure.

The list of commands in the menu evolves automatically as planning elements are added or deleted. When only one planning element exists, for example, the Move commands are disabled because they are not relevant.

The list of commands in the command box is illustrated in Figure 3.8 below. Each command is described in more detail in the table in Figure 3-9 below.

**Figure 3-8: Edit the structure of the logical framework – right-click commands**

![Master Workplan and Costing](image)

In much the same way, the right-click menu can be used to either expand or collapse the item selected. For example, if the cursor is placed on the **objective** row and the **collapse** command is selected, the SDAs, the activities and sub-activities will be collapsed and will no longer be visible. This functionality exists at all levels of the logical framework. It is therefore possible to start reviewing the master worksheet with only certain planning elements visible.

**Figure 3-9: Functionality of various commands**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add:</strong></td>
<td>A new planning element (or group of planning elements)* will be placed at</td>
</tr>
<tr>
<td></td>
<td>the bottom of the current list of planning elements, i.e. if a new activity</td>
</tr>
<tr>
<td></td>
<td>is added, it will be placed as the last activity within that SDA.</td>
</tr>
<tr>
<td><strong>Insert:</strong></td>
<td>A new planning element will be inserted immediately below the item selected.</td>
</tr>
<tr>
<td><strong>Move up:</strong></td>
<td>The selected planning element will be moved up one level in the structure,</td>
</tr>
<tr>
<td></td>
<td>i.e. if an objective is moved one level up it will be placed above the</td>
</tr>
<tr>
<td></td>
<td>previous objective. An activity will be placed above the previous activity,</td>
</tr>
<tr>
<td></td>
<td>and so on.</td>
</tr>
<tr>
<td><strong>Move down:</strong></td>
<td>The selected planning element will be moved down one level in the structure,</td>
</tr>
<tr>
<td></td>
<td>i.e. if an objective is moved one level down it will be placed below the</td>
</tr>
<tr>
<td></td>
<td>following objective. An activity will be placed below the following</td>
</tr>
</tbody>
</table>
activity.

Delete: The entire planning element will be deleted, including its subsidiary components. If an activity is selected and deleted, it will be deleted together with all its sub-activities. Deleting an SDA will result in the deletion of all the activities under that SDA.

Collapse: This command allows the subsidiary items in the item to be collapsed and therefore hidden from view. For example, it is possible to collapse all objectives and view the entire structure at objective level only.

Expand: The expand command will reveal all the subsidiary elements of the planning element selected. In the above example, if an objective is expanded, it will reveal all the SDAs, main activities and sub-activities attached to that objective.

*Note: Throughout this table, reference to a planning element also includes reference to a group of planning elements, e.g. adding an SDA will add an SDA, activity and a sub-activity.

In order to protect the integrity of the logical framework structure, users are prevented from deleting the first planning element in any set of planning elements. For example, if there is only one goal in your structure you will not be able to delete it and the delete command will not appear. The same applies to the first objective, SDA, activity and sub-activity.

### 3.4.4 Input of data

Once a planning element has been added, the appropriate information can be inserted. For each planning element, enter the name of the planning element. For each sub-activity, enter a reference to a previous funding source or sources where the activity is ongoing and the name of the institution responsible for implementation in the respective columns. Select the type of institution from the drop-down list in the Implementing Entity Type column. These are all optional fields but diligent completion of these fields provides for more meaningful analysis once the budget is complete.

The directly related indicator can also be entered at a later stage once the monitoring and evaluation framework has been completed. This facilitates a link between the performance framework and the work plan and budget. Click in the appropriate cell in the Title or Directly Related Indicator columns and type in the required information. For activities, enter a brief description of the activity in the space provided.

If an SDA has been added, select the correct SDA from the drop-down list. This list will reflect the SDAs applicable to the disease selected on the cover page above in Step 1. (See also Editing the SDA List below.)

**TIP:** Build the early versions of the logical framework outside of the tool while significant changes are still being made. Once some consensus has been achieved with respect to the framework, capture it in the tool. This limits the amount of editing of the structure within the tool.

Complete the structure as far as possible in the tool before commencing with the other steps required to populate the tool. A logical framework that keeps changing will lead to inefficiencies.
3.4.5 Selecting service delivery areas

The Global Fund requires that proposals be developed in terms of SDAs. The SDAs define the broad areas in which activities occur and contribute to achieving objectives. Budget summaries are required to be presented by SDA.

The tool includes pre-defined sets of SDAs that are consistent with the SDAs recommended by the Global Fund. Each disease component and HSS has its own set of SDAs that are generated automatically, depending on the disease component selected in the cover page.

To select an SDA, click on Select SDA from list. A drop-down arrow will appear to the right of the cell. Simply click on the arrow and select the appropriate SDA from the list.

WHO recommends that countries try to limit themselves to the use of the pre-defined SDAs whenever possible. These have been approved by the Global Fund and will be easily recognizable to the Technical Review Panel (which reviews the proposals). However, it may occasionally be necessary to add an additional SDA to the list of Global Fund-approved SDAs. To add a new SDA to the drop-down list, right-click on the mouse and select List Add from the command list. You will then be required to enter the name of the new SDA. Place your cursor on the SDA row and select the new item from the drop-down list.

3.5 Step 4: Define input costs

The definition of input costs is divided into two stages in the tool. The first stage is performed in Step 4. This is the definition of the physical inputs required to implement a defined set of activities (e.g. a vehicle). Step 5 is concerned with defining the cost of each input identified (e.g. $20,000 each).

3.5.1 General approach to input costs

This tool uses a single list of inputs and input costs to calculate the costs of sub-activities. Sub-activities are constructed from the bottom up, using detailed inputs as the basic building blocks. Each detailed input and its corresponding cost can be used many times in any number of activities. For example, the input costs might include an entry for one international consultant, and that cost may be equal to €500 per day. This component may figure in several activities, but the activity component and its unit cost data need be entered only once in the chart of accounts. Figure 3-10 below illustrates this principle. Input 1 and its corresponding cost are entered in Activity A and again in Activity B. Input 3 is used in Activities B and C, while Input 2 figures in all three activities.
For optimal use, the tool requires input cost data to be standardized across different activities. The same input cost must be used for all sub-activities that make use of that input cost. For example, if an international expert will be recruited for 5 days for activity 1.1.3.1, another for 10 days for activity 1.5.3.6 and yet another one for 15 days for activity 2.1.3.5, the same input cost figure should be used. In other words, assuming that the international experts referred to above have similar skill levels, then the same daily rate must be used and multiplied by the number of days.

In order to achieve the above consistency, the tool accommodates all input costs on a single input cost sheet. The master worksheet refers back to the input cost sheet to retrieve input cost data.

The tool can accommodate input cost data at any level of detail, but it is recommended to provide for input costs at the lowest level of each input cost unit. Examples of input costs include one salary day for consultants, one salary day or month for regular staff, one day for venue rental, one day of per diem and allowances for workshop participants, one airfare, one vehicle, one dose of medicines, and so on.

However, where several input costs can be combined to arrive at an aggregate input cost, then use of aggregated input costs is encouraged (see Step 5). Note that this function can be used only if all input costs can be included in a single cost category (see below).
3.5.2 Cost categories

The Global Fund requires that costs be classified according to a pre-defined set of cost categories such as human resources, communication materials, infrastructure and other equipment, and so on. The budget summaries must be presented by cost category.

To facilitate proper designation of cost categories, the Global Fund’s set of cost categories is included in the tool. Each input cost must be assigned a single cost category. Unless all the inputs in a sub-activity fall under the same cost category, it is not possible to assign a cost category to a sub-activity or activity.

3.5.3 Data input

The input cost sheet can be accessed via Step 4 or Step 5 on the menu. Both steps are completed on the same worksheet. Step 4 provides for the identification of inputs and Step 5 facilitates the allocation of cost values to each input identified (see Section 3.6 below). Splitting the process in this way is beneficial in certain settings. For example, it may be possible to hand the list of defined input costs (without values) over to a procurement specialist with a request to research and enter the required values. Users can also use Step 4 to consider whether input costs should be aggregated or not.

To access the input cost sheet, click on Step 4 of the menu. The input cost sheet is illustrated in Figure 3-11 below.

Figure 3-11: Defining the input costs on the input cost sheet

<table>
<thead>
<tr>
<th>Description</th>
<th>Active</th>
<th>GF Cost Category</th>
<th>Unit of Measurement</th>
<th>2010 Price in USD</th>
<th>2010 Price in ZAR</th>
<th>Last currency entered</th>
<th>Apply Inflation?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Materials</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Billboards</td>
<td>Yes</td>
<td>Communication Materials</td>
<td>Rental per month</td>
<td>2 000.00</td>
<td>5 000.00</td>
<td>Local</td>
<td>Yes</td>
</tr>
<tr>
<td>Pamphlets and leaflets</td>
<td>Yes</td>
<td>Communication Materials</td>
<td>per sheet</td>
<td>0.07</td>
<td>0.50</td>
<td>Local</td>
<td>Yes</td>
</tr>
<tr>
<td>Product development</td>
<td>Yes</td>
<td>Communication Materials</td>
<td>per hour</td>
<td>100.00</td>
<td>750.00</td>
<td>Proposal</td>
<td>Yes</td>
</tr>
<tr>
<td>Planning</td>
<td>Yes</td>
<td>Communication Materials</td>
<td>per booklet</td>
<td>0.27</td>
<td>2.00</td>
<td>Local</td>
<td>Yes</td>
</tr>
<tr>
<td>General Costs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No description</td>
<td>Yes</td>
<td>General Costs</td>
<td>No UCM-identified</td>
<td>-</td>
<td>-</td>
<td>Local</td>
<td>No</td>
</tr>
<tr>
<td>No description</td>
<td>Yes</td>
<td>General Costs</td>
<td>No UCM-identified</td>
<td>-</td>
<td>-</td>
<td>Local</td>
<td>No</td>
</tr>
<tr>
<td>Health Products and Health</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Infrastructure and Other</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Living Support</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monitoring and Evaluation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overheads</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pharmaceutical Products</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Review the sub-activities that have been defined in Step 3 and consider the type of resources that will be needed during the implementation of the sub-activities. Based on this analysis identify and define the required input costs. Enter the names of the identified input costs in the first column of the worksheet under Description in the green cells provided under the most
appropriate heading (in yellow). The headings are only used as separators in the input cost drop-down list described under Step 7. The headings cannot be edited.

**TIP:** To protect the integrity of the tool, input costs items cannot be deleted completely from the sheet. As noted above, descriptions can, however, be amended. Users should therefore not add input cost items unless they are reasonably certain that the items will be used.

To add a new input cost item, you may either overwrite an existing item or add a new item. To add a new item, place your cursor below the row where you would like to add the new item, right-click the mouse and select the **Add new input cost** command from the command box. A dialogue box will appear that asks the user to indicate how many rows need to be added (see Figure 3-12 below). In the space provided, type in the number of rows to be added. Where an existing item is edited or overwritten, it is important to ensure that the correct cost category is selected and that the unit of measurement is amended.

**Figure 3-12: Inserting input cost rows**

For each item identified, select either **Yes** or **No** in the **Active** column from the drop-down list. Selecting Yes will identify the input cost item as an active input cost item and will display it in the drop-down list used in Step 7. Selecting No will de-activate the input cost item. This is useful where users may not want to overwrite an input cost item, in case they might want to use the item at a later stage.

For each item, select the associated cost category from the Global Fund cost categories included in the drop-down list in the column entitled **GF Cost Category**.

WHO recommends that countries try to limit themselves to the cost categories approved by the Global Fund. Nevertheless, it is possible to create a new cost category. To create a new cost category, place the cursor under the **Description** column, right-click the mouse and select the **Cost category list – add** command from the menu. In the dialogue box, type in the cost category you would like to add. The new cost category will be added to the list in the correct alphabetical order.

Where input costs items can be applied to several cost categories, it may be necessary to enter the item more than once. The only difference between the items would be the cost category selected. For example, transport costs may be allocated to the training cost category or to overheads. In such a situation, create a transport cost item under two separate headings and select different cost categories. (Note that cost categories cannot be subsequently changed in...
Step 7.)

For each item, define and type in the unit of measure in the **Unit of measure** column. It is critical to ensure that the correct unit of measure is described, as this will determine the value to be entered in Step 5. For example, the unit of measure for staff salaries can be either earnings per month, per quarter or per year. Users should consider the need to enter appropriate target quantities during Step 7 when defining the units of measure as well as any directly related indicators.

**TIP:** You can make the input cost list easier to read by minimizing headings that you do not need for the moment. This will hide the subordinate cost items and make it easier to navigate through the input cost list.

To make the list of input items easier to read and administer, it is possible to collapse or expand each heading and its associated input cost items. To expand or collapse the list of input cost items under each heading, right-click on the heading and select either the **Maximize category** or **Minimize category** command from the command box. In the same way select the **Show all** or **Minimize all categories** commands to show all input cost items under all categories or hide all input cost items respectively. In Figure 3.8 above, the Human Resources heading has been expanded and the Technical and Management Assistance and Training headings have been collapsed.

In much the same way it is possible to show only all inactive input costs or show only active input cost items by selecting the respective commands.

**Caution!** Restricted Copy function. It is only possible to copy the cost item description and value from a separate worksheet. The active or non-active cost categories and other functional cells are protected and drop-down boxes must be used to select the correct item.

Once the worksheet has been completed, it can be printed or copied electronically and used to source input cost values for defined items. This may require giving certain sections of the input cost sheet to various relevant government departments, a procurement agency or other reliable source of costing data that can assist by entering the value for each item identified. For example, the Human Resource section of the worksheet can be given to the salaries department in the Ministry of Health for completion. Where this process is well managed and coordinated, significant efficiencies can be achieved.

### 3.5.4 Additional guidance on defining input costs

The benefit of a single input cost approach is that it provides a smaller number of more uniform input cost items upon which to build the cost estimate. It also requires a careful examination of input cost data and helps to ensure a certain amount of consistency in costs across different implementing agencies or geographic locations. A common method for constructing a proposal is to collect portions of the proposal from various sub-recipients, implementing agencies, or geographic areas. This may result in different input cost estimates for the same cost items being received from different implementing agencies or geographic areas.
In some cases these discrepancies may be justified. For example, the cost of renting a venue for a workshop may vary based on its size, quality or location and the choice of venue may depend on the number of participants. Similarly, the cost of hiring an international consultant may differ, depending on his or her level of expertise, place of residence, travel costs and so on. However, if the unit costs estimated by different sub-recipients or implementing agencies differ substantially for no apparent reason, this may indicate that errors have been made or that some cost estimates are unrealistic. In such cases, users should carefully examine the cost data to identify and correct the source of the discrepancies.

Accurately reflecting differences in input costs in the input cost sheet presents a challenge for users. The right balance must be struck between a legitimate differentiation of input costs and keeping the set of input costs to a reasonable size. In most cases, the preferred method is to arrive at an average cost that reflects the average cost of the item based on the best available information. However, when there are obvious and significant differences in costs based on quality, location, capacity or other aspects of the component, these can be reflected by differentiating the activity input costs. For example, there may be one entry for a large venue rental and another for a small venue, or potentially it may be necessary to differentiate input costs by location due to substantial cost differences between one location and another.

In many cases input cost data will be available through government accounts, based on previous expenditures and actual cost data. In such cases a reasonably comprehensive and accurate list of input costs can be constructed from existing data, potentially eliminating the need to rely on estimates from sub-recipients or implementing agencies.

### 3.6 Step 5: Input costs and reference notes

The main purpose of Step 5 is to finalize the input cost sheet by entering a cost value for each input item. Click on Step 5 in the menu to be transferred to the input cost sheet.

#### 3.6.1 Input cost values

This tool allows input costs to be entered in either the local currency or in the proposal currency. The tool uses the exchange rate entered in Step 2 to automatically calculate the alternative value and returns a total in both currencies.

Figure 3-9 below illustrates how to enter cost values. The columns **2009 Price in USD/Euro** and **2009 Price in Shillings** are the relevant columns. The year and the name of the proposal and local currencies will change depending on what you have entered in Step 2.

To enter a cost value, go to the headings for **[Year] Price in USD/Euro** or **[Year] Price in [local currency]**. Enter a cost value in either the proposal currency or the national currency for each input cost item. When a value is entered in the proposal currency, the national currency value is automatically calculated (shaded in green in Figure 3-13 below). The same applies when a value is entered in the local currency – it is automatically converted to the proposal currency.

It is not possible to enter values for both proposal and national currency. The programme will
use only the last value entered and translate that value into the alternative currency. In the column Last currency entered the tool will automatically indicate in which currency the input cost value was entered.

**Figure 3-13: Inserting values and source data for defined input costs**

Input cost values should be entered in the currency that is most often used to denominate and/or procure that input. If input cost items are usually procured with national currency, then enter these values in the national currency column. If the input is usually denominated or purchased with the proposal currency, enter the value in the local currency. For example, items such as local salaries, venue rental, local travel costs, office supplies, utilities and local services are most often denominated and paid in local currency. These items should be entered in the local currency. However, items such as international consultants, imported supplies and equipment, imported pharmaceuticals and so on may be denominated and purchased using USD or Euros. The cost values of such items should be entered in the proposal currency.

It is only necessary to enter cost values for those cost items that are active. No values need be entered for inactive inputs. While the system will allow you to enter cost values for inactive inputs, these will not be used in calculating costs and budgets.

**3.6.2 Exchange rates**

The exchange rate entered in Step 2 can be modified at any time. Any modification to the exchange rate will trigger an automatic recalculation of the budget.

The budget is calculated by multiplying the proposal currency input cost value by the target exchange rate.
quantities entered in Step 7. When input cost values are entered in the proposal currency, a change in the exchange rate will have no impact on the input cost value. However, when the input cost value has been entered in the local currency, a change in the exchange rate will result in a change to the input cost. Any change in the exchange rate will cascade throughout the tool and result in changes to the overall budget figures.

3.6.3 Apply inflation

Users will occasionally find it useful to exclude some costs from the effects of inflation. For example, the prices of antiretroviral medicines can be expected to fall over time, so it would be unrealistic to inflate those prices. The same may be said of computer equipment, communications, etc.

This tool includes a feature to apply or not apply the default inflation rate to individual input costs. Once the input cost item value has been entered, go to the column labelled Apply Inflation? and select Yes or No from the drop-down list. Selecting Yes will apply the default inflation rate to the input cost value over the period of the proposal. Selecting No will result in an input cost value that is static from one year to the next. De-activate the default inflation rate for input cost items that are not expected to increase in price during the proposal period.

3.6.4 Notes

In certain cases, it is possible to define a single recurrent cost item that aggregates a number of input costs. This will be explained further in Step 6 below.

This step requires the user to create a cost calculation note reference. To create a cost calculation note reference, place the cursor in the row of the input cost item in the column with the heading Note. Right-click the mouse and select the Add note command from the command box. This will add a note reference and automatically create a blank cost calculation note in the aggregate input cost calculation sheet (Step 6). The completion of the cost calculation note is described in Step 6 below. A cost calculation note reference can be added at any time, but the process re-sets the input costs value to nil and links the value cell to the note.

To delete the cost calculation note reference and the note itself, place the cursor on the note reference and right-click the mouse. Select the Delete note command from the command box. The re-numbering of the notes will take place automatically.

To view the note from the input cost sheet, place the cursor on the note reference and right click the mouse. Select View note from the command box. The user will be transferred to that specific cost calculation note on the aggregate input cost calculation sheet (Step 6).

3.6.5 Source of data

Often users may forget where a particular cost value was sourced or how it was calculated. Other times, another user may need to use the tool and will need to have access to this information. In such cases it is useful to have a record for later reference.
The **Source of data/assumption** column exists to allow the user to record any observations on the source of the input cost data or assumptions made in calculating the input cost value. To use this feature, enter the source of the value data in the **Source of data/assumption** column on the right of the worksheet. This field can also be used to enter notes or assumptions that refer to the input cost item value.

### 3.7 Step 6: Calculate input costs

As mentioned during Steps 4 and 5, the user may define input cost items that comprise an aggregate of more than one input cost. A typical example might be the cost of training a trainee for one day. This input cost comprises the sum of the cost of the facilitator, venue hire, meals, travel allowances and training material. To arrive at the cost of training a trainee for a day the total aggregate cost must be divided by the number of trainees in the training workshop.

Instead of listing each input for training every time similar training takes place, it is much easier to calculate this just once and to use the cost for training per person per day. In the tool the detailed calculation is referred to as the cost calculation note and is completed as part of Step 6.

This step is useful to simplify the budgeting process and to avoid the need to enter an identical set of inputs multiple times. It also provides the user and reviewer of the budget with the detailed calculation of the aggregate input costs. This level of detail is also necessary once implementation is initiated and a more detailed budget must be prepared.

If a cost calculation note is used, it is very important that the measurement unit in Step 5 accurately reflect the measurement units of the cost calculated in the note.

#### 3.7.1 Using the cost calculation notes

Each time a cost calculation note reference is created in the input cost sheet during Step 5, a blank input cost calculation box is created in Step 6 with the same reference note designation. In Step 6, the user is required to develop the calculation of each aggregate input costs.

The format of the cost calculation note is standardized, but the content of the note is flexible. The user is free to enter any input along with the measurement unit, frequency, and price. An example of the standard format of such a calculation is provided in Figure 3.14 below. In this example, the user has calculated the cost of developing communication material. The total reporting currency value will be transferred to the input cost sheet (Step 5) next to the note reference.

In order to add rows to the input cost calculation note, place the cursor on the note below the headings and right-click the mouse. Select the **Insert rows** command and in the dialogue box enter the number of rows to be inserted. In this way the note can be expanded to the required size.

To delete a row, select the row and right-click the mouse. Select **Delete row** from the command box. To delete the entire note, it is necessary to go back to Step 5 and delete the note from the input cost sheet (see above).
In the input cost calculation box, describe each input and its measurement unit. In the **Quantity** column, enter the number of units of the input required and in the **Frequency** column, enter the number of occurrences. In the example below, 40 hours (quantity) are required to do the research but the research is carried out only once (frequency).

Once the cost ingredients have been defined, enter the item value taking careful note of how the unit of measure has been defined. The same logic and functionality described in Step 5 with respect to entering item values applies. Enter a local currency item value except where a USD or Euro value is more appropriate. As indicated above, the total of the input cost calculation box will automatically be transferred to the input cost sheet (Step 5) and there is no need to manually create a link.

**Figure 3-14: Example of an aggregate unit cost calculation**

<table>
<thead>
<tr>
<th>Product development</th>
<th>Measurement Unit</th>
<th>Quantity</th>
<th>Frequency</th>
<th>2010 Price in USD</th>
<th>2010 Price in ZAR</th>
<th>Last currency entered</th>
<th>2010 Total in USD</th>
<th>2010 Total in ZAR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Research material</td>
<td>per hour</td>
<td>40.00</td>
<td>1.00</td>
<td>66.67</td>
<td>500.00</td>
<td>Local</td>
<td>2 666.67</td>
<td>20 000.00</td>
</tr>
<tr>
<td>Test on focus groups</td>
<td>per group meeting</td>
<td>1.00</td>
<td>10.00</td>
<td>333.33</td>
<td>2 500.00</td>
<td>Local</td>
<td>3 333.33</td>
<td>25 000.00</td>
</tr>
<tr>
<td>Develop material</td>
<td>per hour</td>
<td>100.00</td>
<td>1.00</td>
<td>75.00</td>
<td>562.50</td>
<td>Proposal</td>
<td>7 500.00</td>
<td>56 250.00</td>
</tr>
</tbody>
</table>

**TIP:** Take extra care to ensure that input item values accurately reflect the measurement unit indicated under the **Measurement unit** column.

When calculating aggregate costs, it is extremely important to ensure that input item values reflect the measurement units indicated under the **Measurement unit** column. A common error is to provide for the quantity in the input costs value. For example, suppose a five-day training course is being planned for 50 participants, and one of the cost ingredients is a daily subsistence allowance (DSA) of US$ 30 for participants. The measurement unit for DSA for participants is indicated to be **per day**. In this case, enter only the US$ 30 DSA figure in the EUR/USD price column. Do **not** multiply by five to get the total cost per participant. Enter the number of participants (50) in the **Quantity** column and the number of days (5) in the **Frequency** column.

**3.7.2 Per-unit costs**

Users may sometimes wish to express the aggregate unit cost calculation as a cost per unit of output. Taking the example above for the development of communications materials, the user may wish to express the cost of development as a cost per booklet, rather than the total development cost. Or the cost of a training workshop may need to be expressed as the cost per person trained rather than the total cost of the workshop.
If it is necessary to calculate a cost per unit of output, this can be achieved in two ways:

- Firstly, if the note has been completed to calculate the total cost of the aggregate input, then the total must be divided by the number of units to calculate the per-unit cost. In the cell **Number of units** below the note, enter the number of units. The last two cells (bottom right-hand corner of the note) will then indicate the per-unit cost in both the proposal and the local currency. For example, if the note calculates the total cost of a workshop for 50 people, but the input cost required is a cost per participant, then enter 50 as the number of units. The cost per participant will then be transferred to the input cost sheet (Steps 4 and 5).

- Secondly, amend the measurement units in the aggregate cost note to reflect the per-unit cost. In the example of the training workshop, the measurement unit would be **per participant**. Ensure that the quantity entered for each input is calculated as a per-participant quantity. For example, if a facilitator is employed for five days and there are 20 participants, the quantity to be entered next to that input cost is 0.05. This quantity is derived by dividing the single facilitator by 20 participants. The frequency would remain 5 days for a 5-day workshop. If the second method is used, the **Number of units** cell must reflect a value of 1, which is the default value and must remain.

**Caution! - Number of units should always have a value.** Where the aggregate input cost note does not calculate a per-unit cost and the total of the unit cost note must be transferred to the input cost sheet (Step 5), then the default number of units must remain as 1. Removing the default value will result in a division error (#DIV/0!).

### 3.8 Step 7: Define input cost items and quantities for sub-activities

This is the most complicated step in the process of developing the proposal budget. Completing this part of the master work plan and costing sheet requires a team effort, combing the programmatic knowledge of programme and M & E staff together with the costing expertise of costing and budgeting staff. Users should be prepared to spend considerable time on this step.

The basic logic underlying the master work plan and costing sheet is that the implementation of sub-activities will consume resources. The consumption of these resources generates costs. In most cases, several types of resources will be consumed and therefore generate different input costs for each sub-activity. In order to calculate the budget, the tool multiplies each input cost item value by a target quantity for each period of the budget (quarter). This mathematical process can be represented by the statement \( v \times q \times \pi = c \) where:

\[
\begin{align*}
\text{v} & = \text{Input cost item value} \\
\text{q} & = \text{Target quantity} \\
\pi & = \text{Expected inflation} \\
c & = \text{Total budget value for that input cost item for any given period}
\end{align*}
\]

The variables \( v \) and \( \pi \) will have already been entered in previous steps. In Step 7 the user must select the inputs and estimate the variable \( q \), the number of units of each input that will be
required for each sub-activity for each budget period.

The aggregate of the budget values for all the input cost items under each sub-activity represents the total budget requirement to implement the sub-activity. This budget requirement is presented by budget period and in the aggregate over the five-year time horizon of the proposal.

Step 7 is the final step in developing the budget proposal. This step brings together the information provided in previous steps to finalize the master work plan and costing sheet. Once this step is completed, the master work plan and budgeting sheet will contain all the information required to cost the proposal in one spreadsheet. Budget values are automatically calculated from this spreadsheet and reports can be printed in Steps 8 and Step 9.

### 3.8.1 Selecting inputs

It is most constructive to complete the costing of the logical framework one sub-activity at a time. For each sub-activity in the logical framework, consider what inputs will be required to implement the sub-activity. To select an input, place the cursor on the green cell next to the sub-activity description in the column **Input cost component**. The default description of the green cell referred to is **Select input cost from list**. From the drop-down list, select the correct input cost item. The tool will automatically transfer the measurement unit, the cost category and the input cost item value into the master worksheet.

---

**TIP**: Only the active input cost items (see Step 4) will appear in the drop-down list. The drop-down list appears in alphabetical order under each heading. A heading cannot be selected. These items can only be changed by going back to the menu and accessing the input cost sheet in Steps 4 or 5.

---

For each sub-activity, only one input cost item row will initially be visible. To add an additional input row, place the cursor on an input cost item cell in the column that reads **Input cost component** next to the sub-activity that is being costed. Right-click and select the Add new sub-activity input cost command from the list of commands in the command box (see figure 3-15 below). Enter the number of input cost items to insert in the dialogue box and click **OK**. Repeat the process of selecting an input cost item from the drop-down list as described above.

To insert an input cost item, place the cursor on the input cost item cell above the location where the input cost item must be inserted. Right-click the mouse and select **Insert new sub-activity input cost** from the list of commands in the command box. Enter the number of items to be inserted in the dialogue box, and click **OK**. A new input cost item will be inserted below the cursor position.

To delete or move up or move down an input cost item, repeat the process above and select the correct command from the command box.
3.8.2 Estimating quantities

For each input cost item selected, target quantities must be inserted for each quarter in years one and two and annually for years three to five. To enter target quantities, scroll to the right of the input cost item and enter the correct quantities in the **Quantity columns**. The **Quantity** columns have been highlighted in green for ease of use.

Consider carefully the nature of the input cost item and the measurement unit when entering target quantities. For example, assume a consultant or trainer has been engaged to conduct ten training courses, each of five days’ duration. If the unit of measurement for consultant fees is per day and the input cost value is USD 500, the quantity entered should be 50 (i.e. 5 days each for 10 training courses). It should NOT be, for example, 10 (one per training course) or 5 (5 days for each training course).

Enter target quantities only in those quantity columns corresponding to the timing of planned activities. To continue with the above example, if one training course is scheduled for November of the first year, a quantity of 5 should be entered for the consultant/trainer in the quarter four column **Q4**. If the activity will continue in the first half of the second year, quantities should be entered only in the two columns that correspond to the first two quarters of year two.

If the quarters for years one and two are not visible, then place the cursor on the column heading **Total quantity Year 1** or **Total quantity Year 2**. These cells have also been shaded in green. To view the columns for each quarter, right click the mouse and select the **Show quarters** command. This will expand the columns and reveal the quarters. In the same way, the quarters...
can be hidden while the totals for year one and two remain visible. Collapsing the quarters allows the user to more easily view all five years at the same time on the same screen.

Once target quantities have been entered, the tool automatically calculates the total cost of individual sub-activity input costs by quarter, annually and for the five-year period. Value totals are also provided by activity, SDA, objective and goal. There may be slight divergences in the cost figures due to rounding. These can be safely ignored, as the totals will reflect the correct figures.

**NOTE:** As the tool is being populated it may be necessary to make changes to the logical framework either in terms of its structure or descriptions. The logical framework structure cannot be changed from Step 7. The user must return to the menu and access the logical framework through Step 3.

### 3.9 Step 8: Financial reports

Steps 8 and 9 together comprise a simple report writer. Step 8 allows the user to print summary financial reports, including those required by the Global Fund. Step 9 generates a number of additional reports including the detailed budget and the proposal work plan.

In Step 8, two standard financial reports are provided: 1) Budget summary by main activity and 2) Budget summary by SDA and cost category. The summary by SDA and cost category are required by the Global Fund to be submitted with proposals. The summary budget reports by SDA and cost category are in the format typically required by the Global Fund. Unless formats change, it should be possible to simply copy and paste the output into the tables provided in the main proposal document.

The summary by activity is not required for Global Fund proposals but it can be useful for analysing the results by main activity and for quality control. Applying the principles of trend analysis to the activity report frequently generates useful discussion with the stakeholders and provides a useful overview of where the money is being spent.

Figure 3-16 illustrates the menu for summary financial reports. To access the reports, click on Step 8 in the main menu. Then click on the button corresponding to the report you want to generate. The tool will automatically generate the report and display it on your screen.

The **Budget by SDA and cost category** report includes two tables that show the budget by cost category and the budget by objective and SDA, as shown in Figure 3-17 below.
To print the report in the default format, use conventional Excel print commands, e.g. File > Print Preview > Print. Alternatively, you may copy the entire report onto a worksheet in a new workbook, where the formats can be changed and adjustments made to suit the user before printing. If reports are being copied into a separate workbook, it is important to only copy the values across and then the formats, in that order.

To copy the report across to a new workbook, select the entire report to be copied and click on
the Copy icon in the toolbar or go to Edit > Copy. Next, place the cursor on the top left-hand cell of the destination worksheet and in Excel 2003 select the following commands: Edit > Paste Special > Values. Ensure that the cursor remains on the top left-hand cell of the worksheet and then select Edit > Paste Special > Formats.

In Excel 2007, after copying the report, click on the Paste drop-down list from the Clipboard group on the Home tab and select Paste Special. Select the Values option and click OK. Repeat the process but select the Format option and click OK.

Before printing the worksheet, check all the columns to ensure that these are wide enough to display all the text and values. Adjust other formatting as required, set the print preferences and print the report.

**Caution!** If the simple Paste command is used as is, the worksheet formats will also be copied which will generate '#REF!' errors in the destination workbook. Ensure the Paste Special command is used as described above.

As an alternative to printing report in Step 8, the entire tool can be printed from the cover page in Step 1. See Section 3.11 for details.

### 3.10 Step 9: Other reports

A number of other reports have been included in Step 9. These include the reports shown in the menu options in Figure 3-18 below. A brief description of each report follows below. To print these reports follow the instructions as outlined in Step 8 above or alternatively print the entire tool from Step 1 (see Section 3.11 below).

**Figure 3-18: Other reports menu**

- Detailed budget for years 1 - 5
- Unit costs/ detailed assumptions
- Unit cost calculations
- Proposal workplan
3.10.1 Detailed budget

The detailed budget shows the master worksheet at sub-activity level and all the input cost items for each year, with the first two years by quarter. This report shows all the values but quantities are shown only on an annual basis.

3.10.2 Unit cost / detailed assumptions

This report generates the input cost sheet. It is useful to generate this report and request sign-off of the input costs and all the related assumptions from the client.

3.10.3 Unit cost calculations

This is a report of all the unit cost calculation notes completed during Step 6. Print this report together with the unit cost report, as it will frequently refer to the unit cost calculation notes.

3.10.4 Proposal work plan

The proposal work plan shows the entire master work plan from goal level to sub-activity input cost item level. For each input cost item, the quantities are reflected for all the years and by quarter in years one and two. The total cost for the five-year period is also shown to facilitate reconciliation between the work plan and the detailed budget.

3.11 Print model reports for submission

In Step 1, a print option has also been created to print all the reports listed in the table below in Figure 3-19 but with sequential page numbers, a table of contents and cover sheet. This provides an easy way to print all the reports required for the Global Fund proposal submission and avoids the need to generate and print each report individually, saving time and effort.

Figure 3-19: List of reports included in the Print Model option in Step 1

<table>
<thead>
<tr>
<th>Sheet Number</th>
<th>Sheet name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter annex number-1</td>
<td>Introduction and general assumptions</td>
</tr>
<tr>
<td>Enter annex number-2</td>
<td>Summary budget tables by cost category and SDA</td>
</tr>
<tr>
<td>Enter annex number-3</td>
<td>Summary budget by activity for years 1 - 5</td>
</tr>
<tr>
<td>Enter annex number-4</td>
<td>Detailed budget for years 1 - 5</td>
</tr>
<tr>
<td>Enter annex number-5</td>
<td>Unit costs/ detailed assumptions</td>
</tr>
<tr>
<td>Enter annex number-6</td>
<td>Unit cost calculations</td>
</tr>
<tr>
<td>Enter annex number-7</td>
<td>Proposal workplan</td>
</tr>
</tbody>
</table>

Before printing the tool report in Step 1, check the individual reports to ensure accuracy and consistency of information. To print all the reports in the table above, return to Step 1 of the workflow. Click the Print model button. The tool will generate the reports and transfer the user
to the print preview screen. Review the reports, check the page set-up and then click the Print command on the Excel toolbar.

The reports contain a number of large worksheets summarizing the work plan and budget for the proposal. Due to the large amount of information contained in these reports, readability will be improved if the reports are printed on A3 size paper.

The advantage of printing the entire tool from the above command (as opposed to printing from the report menus in Steps 8 and 9) is that all the reports will be sequentially numbered. This is not the case when printing from the reports menus.

4. **Troubleshooting and support**

4.1 **Technical support**

From time to time, users may encounter problems in using the work planning and budget tool. These problems may be caused by different issues and may in some cases not be related to the tool itself. Some users’ questions may relate to how best to use the tool and others might relate to the functionality of the tool.

As a first step, users should read the relevant section of the user’s manual carefully to make sure that their use of the tool has been correct and that instructions have been carefully followed. Also consider contacting other users of the tool who may have some experience to share. Contacting other users is particularly useful to discuss issues relating to the best use of the tool. For example, discussing questions with colleagues about how best to structure the work plan and at what level to aggregate input costs will often generate the best solution.

As a second option, consider the items described in Section 4.2 Troubleshooting below as a means of resolving the problem.

If neither of these approaches leads to a solution, users should contact the support team for assistance. For assistance, please contact the help desk at help@sdc.co.za with a detailed description of the problem and contact details. A reply email will be sent within 24 hours of receipt providing a possible solution for the problem or acknowledging receipt of the email and indicating the way forward for resolving the issue.

Where a problem with use of the tool has occurred and an error message has been displayed, it is important to include a screenshot or an accurate description of the error message in the email. This will assist the support team to resolve the query.

To create a screenshot of the error message, hold the Control key down and simultaneously press the Print Screen button on your keyboard. Open a blank word document and paste the resulting snapshot of the screen.

Screen shots can be large and should be cropped and reduced to only reflect the error message before emailing. To crop the screen shot, right-click on the image and select Show picture toolbar. Click on the Crop icon and use it to crop the picture down to include only the part you
want to send. Click on the picture and resize using the sizing buttons on the sides and corners of the picture. Once the image has been re-sized, attach it to the email or copy it into the body of the email.

4.2 Troubleshooting

The tool may respond differently depending on which operating system is used (e.g. Windows XP, Vista or Windows 7) and the version of Excel you are using (2003 or 2007). In some cases there may be incompatibilities in the software versions that may cause problems.

The following common errors may occur. Possible solutions for these errors are suggested below.

4.2.1 The programme or certain functions do not respond when I try to use them

This is may happen because the macros are not enabled. To ensure macros are enabled, you must adjust the security settings to the appropriate level before opening the workbook. To do this you must close the workbook and then enable the macros in the workbook as described in Section 2.2.3 (Enabling Macros) in this manual.

4.2.2 The tool is slow to respond and functions such as report printing take a long time

This tool contains a large amount of data and requires considerable system memory and processing capacity. It may take considerable time to run some functions, even when the tool is functioning perfectly. The tool becomes slower when populated with a large amount of programme and cost data. Some complex functions (e.g. updating the master worksheet; generation of reports; adding planning elements) may take 20-30 seconds to run in a fully populated tool.

If the tool is consistently taking longer than expected to process routine tasks such as adding planning elements or generating reports, it may indicate that there is a problem. This may result from:

- using a computer that does not meet the recommended specifications;
- running the tool in parallel with other complicated spreadsheets; or
- using a corrupted spreadsheet.

To address a slow response, first ensure that the computer being used meets the specifications described in Section 2.2.1 above. To check, go to Start > Control Panel > System and security. Click on System and check to see that your computer has at least the capacity outlined below:

<table>
<thead>
<tr>
<th>Item</th>
<th>Capacity Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excel</td>
<td>Excel 2003 or later</td>
</tr>
<tr>
<td>Operating system</td>
<td>Windows XP, Vista or Windows 7</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium 4 or better</td>
</tr>
<tr>
<td>Processor speed</td>
<td>1.69 GHz or better</td>
</tr>
</tbody>
</table>
To check computer specifications in Windows XP, go to **My computer > Control Panel** and click on **System** and then on the **General** tab.

If you are using Windows Vista or Windows 7, you should have a more recent processor (core duo) and at least 3 GIG of RAM.

If these specifications have been met, try shutting down other spreadsheets and applications running while you are using the tool. Consider also the programmes that are launched during start-up, and in consultation with your systems administrator, establish whether some programmes can be disabled.

If these measures do not solve the problem, contact technical support.

### 4.2.3 The totals in the summary budget reports do not match each other

The summary budget reports use look-up commands to search for and match entries for **Cost Category** and **SDA** and then return values for these in the budget reports. Values will not be returned if nothing is selected in these categories, and the summary budget reports will therefore not match the total value of the proposal budget. To ensure the budgets are correct, take the following steps:

1. To ensure that the summary budget by **cost category** is correct, make certain that you have selected a cost category for each detailed cost component in the input cost sheet (Step 4).

2. To ensure that the summary budget by **SDA** is correct, make certain that you have selected an SDA name for each set of activities under an SDA in the master work plan and costing (Step 3).

### 4.2.4 I have pasted data into a cell and now I cannot change it

This may occur if the procedures outlined in Section 2.3.3 are not followed when copying and pasting data. If the simple copy and paste functions are used, you may inadvertently copy formats as well as a cell lock into the tool. Since the workbook is protected, you will not be able to change the data in the cell subsequently.

If this happens you will need to e-mail the tool to technical support. Specify which cells in which worksheets (i.e. which steps) need to be corrected. The technical support team will make the necessary corrections and send the corrected tool back to you.

### 4.2.5 When I perform a certain function a run-time error message appears

Run-time errors usually occur when a macro is running and an error occurs during the execution of the macro. Many different types of run-time errors exist and range from minor errors that do not affect the functioning of the tool to more serious errors that can result in the programme freezing and possible loss of data. Run-time errors may relate to errors in the coding of macros,
but in other cases they may relate to the incompatibility between software, i.e. conflict between the operating system and the version of Excel being used.

When a run-time error occurs, users are requested to take a screen shot of the error and email the error message to the support team as described above in 4.1. If this is not possible (the programme has frozen), please document the error message and number for inclusion in an email. Users should note carefully what they were trying to do in the tool when the run-time error occurred.

As a possible solution, run the tool on another computer to establish whether the same error occurs on that computer. If the error is caused by incompatibility of software on a particular computer, then this may solve the problem and facilitate further work with the tool.

Users are reminded to keep regular backups of their proposal budgets to minimize the possible loss of data that might result from a run-time error.